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COPYRIGHT © 2011, 2016  Pennington Publishing 
  
NOTICE TO THE READER 
 
 All rights reserved Pennington Publishing 2011. Permission is hereby 
granted to the individual purchaser to reproduce student materials in this book for 
noncommercial individual or classroom use only. Purchase of The Pennington Manual 
of Style grants you, the purchaser, and your students full license to use these resources 
at school and at home.  
  
Material from this book has been previously published in the author’s Teaching Essay 
Strategies © 2001, 2011, Grammar, Usage, Spelling, and Mechanics © 2013, Teaching 
Grammar and Mechanics © 2003, 2011, and Teaching Reading Strategies © 2008. 
These curricula are available for purchase at www.penningtonpublishing.com. 
  
Other than the heretofore specified limited permission for reproduction, the text of this 
publication, or any part thereof, may not be reproduced or transmitted in any form or by 
any means, electronics or mechanical, including photocopying, recording, storage in an 
information retrieval system, or otherwise, without prior written permission of the 
publisher. 
  
The Publisher makes no representation or warranties of any kind, including but not 
limited to, the warranties of fitness for particular purpose or merchantability, nor are 
any such representations implied with respect to the material set forth herein, and the 
publisher takes no responsibility with respect to such material. The publisher shall not 
be liable for any special, consequential, or exemplary damages resulting, in whole or 
part, for the readers’ or students’ reliance upon, this material. 
 
Curricula Designed to Teach the Essay e-Comments Content 
 
The Essay e-Comments have been derived from the following comprehensive curricula: 
Teaching Essay Strategies, Grammar, Usage, Spelling, and Mechanics, 
Teaching Grammar and Mechanics, and Teaching Reading Strategies and 
are available at www.penningtonpublishing.com. Each curriculum uses the same 
language of instruction as does The Pennington Manual of Style. Each curriculum 
provides diagnostic assessments to determine the individual needs of students in 
writing, spelling, grammar, mechanics, and reading. Each curriculum provides targeted 
worksheets with formative assessments and activities to enable the teacher to 
differentiate instruction.  
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Introduction 
 
The Pennington Manual of Style has been designed to serve both students and teachers.  
  
The user-friendly The Pennington Manual of Style provides 438 writing tips. Each 
writing tip has a concise definition, explanation, and a clear example. Writing tips are 
organized into these categories: Essay Organization and Development (Introduction, 
Body, and Conclusion), Coherence, Word Choice, Sentence Variety, Writing Style, 
Format and Citations, Parts of Speech, Grammatical Forms, Usage, Sentence Structure, 
Types of Sentences, Mechanics, and Conventional Spelling Rules. As a quick reference 
guide, this style manual will help developing writers learn what is correct and why it is 
correct.  
  
For teachers, this guide will provide a common language of writing instruction and 
discourse for teachers and students. Teachers will find the concise writing tips useful for 
both direct instruction and essay comments. And most importantly, all 438 writing tips 
have been formatted as Essay e-Comments for the Autocorrect function of Microsoft 
Word®. After adding in the comment bank, the teacher simply types in the assigned 
alphanumeric code and the entire formatted writing comment appears where desired on 
the student’s Word document or on a printed comments page. Batch load into Google 
Docs if you wish. 
 
The Pennington Manual of Style (included in Teaching Essay Strategies) includes the 
download all 438 Essay e-Comments. The following instructions show you how to 
manually insert the Fallacious Reasoning essay e-comments into Microsoft Word®.  
The comments work fine with Google docs. Simply batch download into Word®, open 
the docs in Word® and insert the comments. Upload back to Google docs, if you wish, 
and maintain the comments. 
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How to Add the Fallacious Reasoning e-Comments and Your 
Own Permanent Autocorrect Entries into Microsoft Word® 
 
1. You can add my e-comments and your own into permanent storage on Microsoft 
Word®. Here’s how: Copy and paste or type the e-comment. The text can include up to 
255 characters of hyperlinks, different fonts, colors, italics, boldface, etc. Highlight, but 
don’t copy the e-comment. 
 
2. Click the Microsoft Word® File. Then click Options. Next click Proofing. 

 

 
 
3. Now click AutoCorrect Options. This page is similar in all recent Microsoft Word® 
versions. The highlighted text will appear within the With: text box.  
 
4. Enter an alpha-numerical code in the Replace: text box and click OK. You’re done! 

 

 

Here is where the highlighted text appears. 
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Fallacious Reasoning e-Comments 
 
e31 Synonym Errors A term has been substituted for another, yet the terms are not 
same. Example: The undemocratic government had only one political party-a true 
dictatorship. Explanation: The writer substitutes dictatorship for undemocratic; yet not 
all undemocratic governments are dictatorships. 
 
e32 Non Sequitur Errors The conclusion cannot be reached from the facts presented. 
Example: If the sky is blue, and blue is the color of the ocean; then the sky must be 
made of ocean water. Explanation: The conclusion that “the sky must be made of ocean 
water” does not follow logically from the facts presented. 
  
e33 Red Herring Errors An unconnected reference distracts the reader from the 
argument. Example: Poverty is the most important problem; however, the world has    
always had poor people. Explanation: The second clause attempts to distract the reader 
from the issue of poverty as the most important problem. 
 
e34 Unsupported Generalization Errors A generalization has been made from a 
fact without justification. Example: Bob and Ara are blondes. They both excel at 
sports. All blondes excel at sports. Explanation: The fact that two blondes are good at 
sports does not justify the generalization for all blondes. 
  
e35 Poisoning the Well Errors The argument is weakened by a criticism in the 
argument itself. Example: The president proposes lowering taxes to encourage 
spending, even though economists label the plan as “unworkable.” Explanation: The 
president’s proposal is weakened by the economists’ comment.  
  
e36 Cause and Effect Errors No necessary cause-effect relationship has been 
established. Example: That cough syrup commercial aired again. I coughed again. 
Cough syrup commercials make me cough. Explanation: Coughing after a commercial is 
a matter of coincidence. Commercials do not cause coughing. 
  
e37 Begging the Question Errors Something unproven has been assumed to be true 
in order to support the argument. Example: No one likes the poor musicianship of 
country music. Explanation: The statement assumes that country music has poor 
musicians in order to support the argument. 
  
e38 Either-Or Errors A false choice has been made between two ideas or issues that 
ignores other options. Example: Either you support the president, or you are not a true 
American. Explanation: The statement ignores other options that true Americans might 
choose.  
  
e39 Comparison Errors Similarities or differences have been made between two 
unrelated ideas or issues. Example: The price of Chinese tea has increased and so has 
the price of American gasoline. Explanation: The price of tea and gas are unrelated 
issues and cannot be compared. 
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e40 Questionable Authority Errors A source has been cited that does not have 
established expertise. Examples: Experts say the world will run out of oil in 9 years, 
and a Harvard scientist claims that love at first sight is possible. Explanation: “Experts” 
are unnamed, and a scientist is not an expert in love. 
 
e41 Contradiction Errors This statement contradicts what has already been stated in 
the argument. Example: Skateboarding is the safest sport. Skateboarding injuries 
result in more hospital visits than any other sport. Explanation: Skateboard injuries 
contradict the claim that the sport is safe. 
  
e42 Inconsistency Errors One part of the argument does not agree with or is 
inconsistent with another part. Example: Children should wear helmets while riding     
bicycles, but not while in-line skating. Explanation: The assertion that one activity 
should require helmets, but not the other, is inconsistent.  
 
e43 Omission Errors Necessary information is missing in the argument.  
Example: The Folsom High School Band has the best band in the city. Explanation: 
The fact that the Folsom High School Band is the only band in the city has been omitted. 
  
e44 Oversimplification Errors A complicated idea or issue has been oversimplified. 
Example: Baseball is a simple game of pitching, running, hitting, and fielding.    
Explanation: This statement ignores the complicated components such as baseball 
strategy, substitutions, and statistical probability.  
  
e45 Sampling Errors This conclusion cannot be made due to insufficient sample size 
or an unreliable sample group. Example: Everyone should floss daily. Three out of four 
dentists agree. Explanation: Only four dentists were surveyed and some may be paid by 
dental floss companies to promote their product.  
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How to Insert Essay e-Comments into Microsoft Word® and 
Google Docs (Grading and Responding to Student Essays) 

 
The Pennington Manual of Style (included in Teaching Essay Strategies) includes the 
download all 438 Essay e-Comments. The following instructions show you how to 
manually insert the Fallacious Reasoning essay e-comments into Microsoft Word®.  
The comments work fine with Google docs. Simply batch download into Word®, open 
the docs in Word® and insert the comments. Upload back to Google docs, if you wish, 
and maintain the comments. 

 
2. Open up a student’s essay in Microsoft Word®. Use the Quick Reference Guide with 
the alphanumeric entry codes and a short comment description, to guide your essay e-
comment selection. The Quick Reference Guide organizes the essay e-comments into 
writing response categories. Highlight the ones you use most often. 
 
3. Go to the Review tab in the Comments group. Left click the mouse where you want 
to place a comment. Click the New Comment image. In older Microsoft Word® 
versions, go to the Insert tab and then to Comments. 

 

 
 
4. The comment balloon will appear in the right margin or in a reviewing pane at the 
bottom of the screen or to the left of the screen. Adjust the comment location under 
Reviewing Pane in the Track Changes group. The keyboard shortcut to include a 
new comment is Ctrl + Alt + M. 
 
5. Type in the alphanumeric code for the selected essay e-comment and full comment 
appears in the comment balloon or where you decide is best. 

 

 
 
6. For repeated errors, simply highlight the text. The yellow marker is found under the 
“Home” tab. Of course, not every error need be marked. Consider using a balance of 
content and process essay e-comments, depending upon the instructional focus and the 
needs of each writer. 
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7. You can also personalize comments by adding to the comment balloons. You can even 
add audio comments to summarize overall strengths and weaknesses. To add an audio 
file (Sound Recorder) into Microsoft Word®, open Start; open All Programs; open 
Accessories; then open Sound Recorder. Click the button to start and stop 
recording. The Save menu will pop open and you can create a folder to save all of your 
audio files. Once saved, open up the folder and right click to copy the WMA file. Place 
your cursor where you want the file to appear in the student’s essay and paste Ctrl + V. 
The Sound Recorder file stays minimized as you open up other Microsoft Word® files, 
so you don’t have to go through the process each time. For better sound quality, I 
suggest using a microphone. 

 
8. Teach your students to revise and edit their documents in response to your essay e-
comments. I suggest using Microsoft Word® Track Changes. Teach your students to 
go the Review tab and click on Track Changes, then revise and edit their document 
by inserting, deleting, moving, or formatting text. The resources in Change Tracking 
Options provide custom color and formatting options. The keyboard shortcut to turn 
on Track Changes is Ctrl + Shift + E. 
 


